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1 GETTING STARTED

1.1 Scope of this Manual

This document serves as a user manual for the API12540 Liquid Volume Correction User Program
(QER 03Q008), intended for use with the ROC300-series of Remote Operation Controllers (ROCs)
with a FlashPAC, version 2.12 or greater, and FloBoss™ 407 Flow Manager, version 1.08 or greater.
This manual describes how to download, configure, and monitor the program. The user program is
accessed using ROCLINK™ for DOS configuration software version 2.23. The configuration software

uses an IBM-compatible computer and Windows” Operating System. For information on use of the
API2540 program with ROCLINK 800 configuration software, refer to user manual Form A6167.

1.2 Organization of this Manual

In this manual, the sections are arranged to provide information in the order in which it 1s required for
first-time users. Once you become familiar with the procedures, and the software is running in a ROC
or FloBoss 407, use the manual as a reference tool.

The manual is organized into the following major sections:

Section 1 Getting Started
Section 2 Installing the User Program
Section 3 Configuring the User Program

Appendix A Standards
Appendix B Domain Violations
Appendix C  Engineering Units

This manual assumes that the user 1s familiar with the ROC300-series and FloBoss 407 units and their
configuration. For additional information, refer to the:

¢ Type ROC306/ROC312 Remote Operations Controller Instruction Manual (Form A4630).
¢ Type ROC364 Remote Operations Controller Instruction Manual (Form A4193).

¢ FloBoss 407 Flow Manager Instruction Manual (Form A6013).

¢ RLIOI ROCLINK Configuration Software User Manual (Form A6051).

<* NOTE: “ROC” 1s used 1n this manual to stand for all ROC and FloBoss devices.

1.3 API2540 Liquid Volume Correction User Program Overview

The Liquid Correction Program is designed for the ROC300-series units equipped with FlashPACs and
the FloBoss 407. The Liquid Correction Program corrects the measured flow of crude oils, o1l
generalized products, LPG, and water by converting values to standard temperature and pressure
levels. The Liquid Correction Program monitors the current flow rate, temperature, and pressure, and
to calculate a corrected flow value for standard conditions based upon density value, sediment, and
water percent value, vapor pressure, and the meter slippage factor.

Rev 05/04
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The Liquid Correction Program accumulates the volume of the flowing fluid and can be configured to
perform calculations for up to three different flows in the ROC306 and ROC312, five flows in the
ROC364, or four flows in the FloBoss 407.

The Liquid Correction Program tracks two accumulated volumes for each flow. One accumulation is
the volume since contract hour or last manual reset and the second accumulation is a running total that
rolls over at 9,999,999, At contract hour or manual reset, flow and minutes today are transferred to
flow and minutes yesterday.

The Liquid Correction Program supports the following liquids:
¢ Crude o1l
¢ Generalized oil products (jet fuel, diesel, oil, and gasoline).
¢ LPG (Liquefied Petroleum Gas).
¢ Water.

The Liquid Correction Program supports the following standards:

¢ API2540 Tables 5A, 5B, 6A, 6B, 34, 53, 53A, 53B, 54, API21, API5, AGA3/1992 and was
developed according to API/ANSI/AGA standards. Refer to Appendix A for a list of all
applicable standards.

The Liquid Correction Program supports the following types of inputs:
Pulse (mass or volume).

Analog Flow (mass or volume).

Analog Differential Pressure (DP).

Density.

Vapor Pressure.

> & & > > »

Water and Sediments.

An uncorrected flow can be determined by one of the following inputs:
¢ Pulse Input (such as from a turbine).
¢ Analog Input (such as from a Vortex or MicroMotion).
¢ Differential Orifice Metering (flange taps only).

1.4 Domain Limitations Handling

The Liquid Correction Program application domain is limited, by API standards, to correcting the flow
of densities, pressures, and temperatures within a custody transfer degree of accuracy. The domain
borders vary according to the product class and parameter values. The calculation automatically adjusts
the Liquid Type between LPG and Crude Oi1l if the input density fluxuates

Whenever a domain violation occurs, an error message displays and stored in the Event Log, with the
ERR tag, the Domain Limit as “old value”, and the Current Value of the parameter. When the violation
clears, “No Error” displays and a clear event 1s logged with the CLR tag. A real-time stamp 1s
appended to each event. In error mode, calculations use the closest domain formulas.
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%+ NOTE: Further interpretation of the volumes calculated and accumulated during domain violation
periods 1s the user’s sole responsibility.

Because domain limits for flowing pressure corrections and flowing temperature corrections overlap,
the Liquid Correction Program assumes temperature-driven domain below 500 kPa (75 PSIA) and
pressure-driven domain above 500 kPa. The associated error is less than 50 PPM.

1.5 Program Names and Versions

Program versions and names display in Table 1-1. You must download two user programs.

Table 1-1. Versions and Program Names

User

User

Program Name T : Code Blocks Data Blocks | ROC or FloBoss Version
ask | Point

ap1_3a.h00 3 28-29 | CO000-CFFFF A0000-ABFFF | ROC306/312/364
FlashPAC versions 2.12
and 2.20

apitbl3a.h00 3 28-29 | CO000-CFFFF A0000-ABFFF | ROC306/312/364
FlashPAC versions 2.12
and 2.20

ap1 3b.h00 3 28-29 | DO000-DFFFF B4000-BFFFF | ROC306/312/364
FlashPAC versions 2.12
and 2.20

apitb13b.h00 3 28-29 | DO000-DFFFF B4000-BFFFF | ROC306/312/364
FlashPAC versions 2.12
and 2.20

api3a_1c.h00 3 28-29 | AO0O0O-AFFFF B0000-BBFFF | ROC306/312 FlashPAC
versions 2.12 and 2.20 for
Industry Canada

ap3tblic.h00 3 28-29 | AO0OOO-AFFFF B0000-BBFFF | ROC306/312 FlashPAC
versions 2.12 and 2.20 for
Industry Canada

api4a 1c.h00 3 28-29 | 60000-6FFFF 70000-7BFFF FloBoss 407 version 1.08
for Industry Canada

ap4tblic.h00 3 28-29 | 60000-6FFFF 70000-7BFFF FloBoss 407 version 1.08
for Industry Canada

api_4a.h00 3 28-29 | CO000-CFFFF 74000-7FFF FloBoss 407, version 1.08

apitbl4a.h00 3 28-29 | C0000-CFFFF 74000-7FFF FloBoss 407, version 1.08

api_4b.h00 3 28-29 | BOO0OO-BFFFF 60000-6BFFF FloBoss 407, version 1.08

apitbl4b.h00 3 28-29 | BO0O00O-BFFFF 60000-6BFFF FloBoss 407, version 1.08

1-3
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2 INSTALLING THE USER PROGRAM

This section describes how to download and install the user program into the ROC306/312/364 with a

FlashPAC (version 2.12 or greater) and FloBoss™ 407 Flow Manager (version 1.08 or greater), using
ROCLINK for DOS Configuration Software (version 2.23). For additional information on

downloading the program, checking memory allocation, and enabling the program, refer to the RL101
ROCLINK Configuration Software User Manual (Form A6051).

2.1 Customizing ROCLINK

ROCLINK for DOS requires several files to use the API2540 Liquid Volume Correction User
Program:

1. Navigate to the CD-ROM directory where the gas flow calculation installation files are
located. Program files are typically located in the Program Files/ROCLINK Files folder on
the CD-ROM.

2. Select and Copy the following files:
¢ menu3.txt

menu4.txt

scl_apil.tpl

scl_regl.tpl

> &+ & <

tiplist.txt

3. Paste the files in to the ROCLINK default working directory.

The default directory 1s located at:
C: \ROCLINK

*

* NOTE: Select Yes if prompted to overwrite existing files.

4. Right-mouse click on the selected files.

Select Properties.

Fle Edit Yiew Favort “|
$Back ~ = - F] | o
addiess [y 50 »| Go | Liks ®

Dpen

Oper With. ..

& AddtoZip

&5 Zip and E-Majl 2 50.z2p

Scan with MoAfes ViusScan

Send To ¥

Cut
Lopy

Create Shorbout
Delete
Rename

B -

Figure 2-1. Properties

Dizplays the
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7. Click OK.

*

FLOW . MON. ... Properties
m 10 Files, 0 Folders
Type: Multiple Typesz
Location: Allin CA_T awnivFshertS partantl 50 5167 3588 Ga
Size: 718 KB [736,213 bytes)
Size ondisk: 836 KB [917.504 bytes)
Abtributes: r'ﬁﬁiﬁﬁk
™ Hidden
W Archive
ok | cancel | Appb

Figure 2-2. Attributes

2.2 Downloading the User Program

To download the user program:

2-2

~ ROCLINK

e o CllElel 8] @S] A

* NOTE: Customize ROCLINK before downloading the user program.

Connect the ROC or FloBoss to your computer through the LOI port.
2. Launch and logon to ROCLINK for DOS.

Select Utilities > User Programs.

eter

bUMHN——b 3ttt
7a888——73ffEf
alBld——alifff
haBBA——h3ff f
cABBA—c3fff
d888A——dhf f f

Open ROC files,

/0 D ta

ureGas  isp

babn—6 '/ttt
74808 EE
a4l ——a M ff
h4888—-bh7f £ £
c4808—-c P f
dcBAB—Af ff§

Connect ROC,. ...

bEEUUR—bhift
78088—7hif £
aBBA——ahfff
h838BA——hhbf f £
cB8ABB——chfff

bGocHEN——GEE LT
JcBB0——7fFFF
acBHBB——affff
bhcBB@——hf f £ £
ccBB@——cffff

On Line : COM2

Figure 2-3. User Programs

6. De-select the Read-only Attribute for each program file that has the Read-only Attribute set.
If the files remain Read-only, ROCLINK will not connect to the ROC or FloBoss.
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4. Determine the Unused Memory Blocks. The memory location must be available for the
specific user program that you are loading.

5. Determine whether program A or B is required. The A and B programs are identical other than
the location in which they load into ROC memory. Refer to Table 1-1.

6. Click DownLoad and select the user program file to download from the CD-ROM. Program
files are typically located in the Program Files/ROCLINK Files folder. The Open File dialog
displays the names of all the files that have the . HOO extension.

*

*+ NOTE: You must download two user programs. Refer to Table 1-1, Versions and
Program Names.

Dpen File

\P3TBLIC.HB@

Figure 2-4. Open File

7. Select the User Program file you desire to load and click OK.

Device User Program Names
ROC306/312/364 api_3a.h00 and apitbl3a.h00
ROC306/312/364 ap1_3b.h00 and apitbl3b.h(00
ROC306/312 api3a_ic.h00 and ap3tblic.h00
(Industry Canada)

FloBoss 407 api_4a.h00 and apitbl4a.h00
FloBoss 407 api_4b.h00 and apitbl4b.h00
FloBoss 407 api14a_ic.h00 and ap4tblic.hO0
(Industry Canada)
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2-4

8. Click More Files to download the second user program.

= ROCLINK

ae =l el B

LU —b 3ttt
7A08a——73fFFF
avbeay—aittt
bABBA——h3fF ¥
cHBAA———c3fff
dBABEA——dbf f F

DownLoad

segment =b6HHEA

b4 —6 '/t £ f
74808 E E
ad—alrrt
h4888—b?f F £
cABdd—c' M F f
dcBAA—df fFF

Hoddressz=1Hel Block Si=ze=244,

|| Al
P D

bEUMB—G6 bt £
78088 —7hi £ £
avbd—abtt
b8BB—bhbf f £
cBABB—chfff

becHEN——bEEE T
JcBB0——7fFFF
acHan—at rrf
bhcB8@——hf f f £
ccBBA—cffff

lTotal Sent=432H

UOn Line GO

Figure 2-5. User Programs Ready to Download

9. Select the User Program file you desire to load and click OK.

10. Click DownLoad to download the selected user programs.

After the user program is loaded, the user program is automatically turned on. This

automatically enables the program run Flags and performs a Warm Start. The Status field
displays ON or OFF indicating the Status of the user program.

= ROCLINEK

ao = CilEe] & =S| Al

YoBBBa——YEFLEf
acBBl—affff
bcBBA—hff L f
ccABR——cFfff

Upen HOG files.,

avbv——adfff
hBAAA—h3f f
cBABA—c3fff
d8HAN——dbf f §

Connect ROG,. ...

At —a it I
h4@88—bL7f | £
c40B8—c M E f
dcHBB——df FFF

(RY515 1510
GEfff

At ——aht f§
h8BBA——hbf f £
cBBEA——chiff

+HEUY
Yhiff

On Lime = CGOMZ

Figure 2-6. User Program Downloaded

NOTE: Only one user program displays even though you installed two programs.
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11. Select System > Flags. Refer to Figure 2-7.

Y% ROCLINK

e = G| B == Al
. e e

ROC Flags

ﬁ ctive
ctive Of D
ctive Option 3

ROC files, Connect ROC, ... On Line:=COM2

Figure 2-7. ROC Flags

10. Select Active under the Calc User Program option. Refer to Figure 2-7.
11. Ensure that the Write to EEPROM button displays Yes. Refer to Figure 2-7.
12. Click Save. This ensures that the program automatically restarts after a Cold Start.

+

¢ NOTE: Remember to de-select the Read-only Property of all user program files. Refer to
Figure 2-2.

2.3 Update Firmware

If the firmware version does not match the recommended version displayed in Table 1-1: Versions and
Program Names, proceed with the following firmware update procedure. The firmware is available
from your sales representative or from technical support.

Update Firmware updates the internal firmware Flash memory of the FloBoss 407 or the ROC300-
series FlashPAC by loading it from a file.

% NOTE: The Update Firmware procedure clears the configuration of the ROC or FloBoss and
reloads configuration from EEPROM after the update procedure is completed. The Event Log,
Alarm Log, Audit Log, and History logs are cleared. To preserve the contents of the logs, be sure
to save them to a file (Collect ROC Data) before starting. The Event, Alarm, and History Logs
cannot be reloaded.

I. Create a backup of the log data using File > Collect ROC Data > All.
Save all FSTs to a disk file.

2
3. Select System > Flags. Refer to Figure 2-7.
4

Click Write to EEPROM and click Save and wait for the save process to complete. This may
take several minutes for ROC300-series units.

5. Read the README text file included with the firmware update.
6. Select File > Update Firmware.
Rev 05/03 2-5
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8.

10.

11.
12.

Navigate to the location of the firmware File Name in the Open File dialog box.

You can change the path to the directory containing the file using the Directory / Drive field
using the <Enter> key or by double-clicking on a different drive or directory. Select ©..” to
move up a directory. The Open File dialog displays the names of all files with the . LST

extension located in the current directory.

..:'.- i

'THH 92 . LST

Figure 2-8. Open File

Select the desired file in the Files list and click OK to start the Update Firmware process.

%+ NOTE: If you receive an error such as “File gas85.fsr is missing or bad,” refer to Section

2.3.1, Altering Your .LST File, on page 2-7.

The file begins loading, with the Status Line displaying the progress in four categories:
Segment, Address, Block Size, and Total Sent. While Flash memory 1s being modified, the
[/O 1s not read, but 1s held at the last values.

The loading process typically takes several minutes; do not disturb it during this time. If
you are running ROCLINK under Windows 95/98, you can adjust the miscellaneous
properties of the ROCLINK window to allow you to leave the window without interrupting
the download (Allow Screen Saver and Always Suspend should not be selected, and Idle
Sensitivity should be set to Low).

Click OK in the history lost prompt.
Press <Enter> after the firmware upgrade is complete.

When loading of the firmware is complete, the action is recorded in the Event Log and a
message line appears saying that the FloBoss has been successfully upgraded. Press <Enter> to
return to the ROCLINK menus.

Select System > Flags and click Cold Start. Refer to Figure 2-7.
Select Restore config from flash/defaults and click OK.

Cold Start Options

e g from ashsdefaults
Restore config and clear alarmsevent
Restore config and clear ROC display:
Restore config and clear F8Ts

lestore config and clear histor
Restore config and clear all of abc

Figure 2-9. Cold Start
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13. Click Save to reload the configuration from EEPROM. Refer to Figure 2-7.

14. Check the configuration and the FSTs. If the configurations are incorrect, reload the
configuration and the FSTs from the files previously created.

2.3.1 Altering Your .LST File

You may be required to change the path in your . 1st file if you copied the firmware files to a
different directory than the directory that was specified in the Readme.txt.

To alter the path, follow these steps:

I. Open the .1st file in a text editor such as Notepad.

& Firm_92_Ist - Notepad

File Edt Search Help

F:\roc firm\fb 188\487 92 _fsr =
c:\roc_ Firm\fb 108\mu205.fsr
c:\roc_firm\fb_ 108\pid.fsr
c:\roc_ firm\fb 168\logic.fsr
c:\roc_firm\fb 108\1lcd.fsr
c:\roc_firm\fb_ 108\db.fsr
c:\roc_firm\fb_108\gas92.fsr

-

4 ol

Figure 2-10. Changing a Directory Path

2. Change the path to reflect the same directory where you copied the upgrade files. Be careful
not to alter the file names.

3. Save your changes and exit Notepad.

Rev 05/03 2-7



API2540 Liquid Volume Correction User Program

2-8 Rev 05/03



API2540 Liquid Volume Correction User Program

3 CONFIGURING THE USER PROGRAM

3.1 API2540 Setup
Select API12540 > API 2540 Setup to display the API Setup screen. Refer to Figure 3-1.

' ,';Hm:um: =101

[ 2o =] |E‘=|E,| E:5|| |g|5| _|

tilities

Jown s Tre am

Open ROC files,. C C W, ... On Line:GCOH2

Figure 3-1. API 2540 Setup

Point Tag — Enter a ten-character name used to label the meter run upon which the flow computation
is performed.

Domain Status — Current Domain Status, such as violations, inactive, or everything within limits.
Statuses are archived in Event Log. Refer to Appendix B, Domain Violations, for error messages.

Units — Click to select US (English / Imperial) units or Metric units for calculations. If Metric units are
selected, then the calculation expects all inputs to be in terms of the indicated units (such as KPa
for the Static Pressure input).

Liquid Type — Select the type of liquid in the meter run:
¢ Water.

Crude Oi1l.

Gasoline, Condensate.

Jet Fuel.

Diesel O1l.

LPG (Liquefied Petroleum Gas).

Transition.

> & & &+ & <
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Table 3-1. Liquid Types

Liquid Type

Metric

US

Low Density

High Density

Low Density

High Density

Crude Oil below 610.5 kg/m’ | above 1075 kg/m” | above 100 deg API | below 0 deg API
Gasoline * below 653 kg/m’ above 770.5 kg/m” | above 85 deg API | below 52 deg API
Jet Fuel* below 787.5 kg/m’ | above 829 kg/m’ above 48 deg APl | below 37 deg API
Diesel* below 829 kg/m’ | above 1075 kg/m’ | above 40 deg APT | below 0 deg API
LPG below 495 kg/m” | above 610.5 kg/m” | above 155 deg API | below 100 deg API
Transition®* | below 771 kg/m’ above 787 kg/m’ above 52 deg APl | below 48 deg API

&

++ NOTE: *Domain violations are triggered at contract conditions. The program automatically

switches to the proper operating range, using the corrected density value, when one of the indicated
ranges 1s selected.

Calc Vapor Prs — Click to unlock (Yes) or lock (No) the calculated vapor pressure feature. When the
Liquid Type 1s Gasoline, Condensate, or LPG, the Calc Vapor Prs option is unlocked (Yes), for all

other liquids it is locked (No).

Scan Period — 50-millisecond interval the flow 1s set to run. When 1t 1s set to less than 10ms, the flow
does not run, and the *"Not Active !!!” message displays. You must reset this parameter with the
number of flows, particular configuration of the liquid flow, and general configuration of the ROC.

Scan Time — Value calculated and displayed by the ROC for each scan, in seconds. If an unrealistic
setting is in place for the Scan Period, the ROC cannot keep the calculation speed in place with the
desired value, so significant differences will occur between the Scan Period and Scan Time, with a
correspondent increase 1n Central Processor Unit (CPU) loading.

Meter Type — Select the type of meter being used:

¢ Pulse.

¢ Analog.

¢ Orifice Plate.

Alarming — Select Enable or Disabled.

¢ Enabled — Click the Alarms button to configure alarms for this point. Alarms are logged to the
Alarm Log. Refer to Section 3.1.3, Alarms, on page 3-5.

¢ Disabled — No alarm generates for this point, regardless of the Alarms configuration.

Meter Input — Select the Meter Input: Volume or Mass. When the Meter Type 1s Orifice Plate, the
Meter Input is always Volume.

Calc Output — Select the Calculation Output: Volume or Mass.

Static Press — Select the Static Pressure mode: Gauge or Absolute.

Static Press Tap — Select if the Static Pressure 1s Downstream or Upstream of the orifice plate.

3-2
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Pipe Diam — Internal diameter of the pipe entered in millimeters or inches. Meter Type Orifice Plate
only.

Orifice Diameter — Diameter of the orifice entered in millimeters or inches. Meter Type Orifice Plate
only.

Viscosity — Viscosity of the flowing fluid at base conditions (cP or Lbm/Ft-s). Meter Type Orifice
Plate only.

Contract Temp — Contract Temperature of 15 Deg C or 60 Deg F. An invalid setting generates an
error message and 1s logged. Contract Pressure 1s always assumed to be 101.325 kPa or
14.73 PSIA.

(F1)Update — Click to refresh the screen with current values.
(F2)Prev — Click to view the previous point.
(F3)Next — Click to view the next point.

(F8)Save — Click to save the changed data.

3.1.1 Calculations

Select AP12540 > API 2540 Setup and click Calculations to define the Accum Reset Mode, and also
clear the accumulated values. The calculated values of Density and Correction Factors also display.

APl Calculations

Figure 3-2. API Calculations

Accum Reset Mode — Select the accumulated reset mode option:

¢ At Contract Hour — At contract hour the program automatically transfers flow volume and
minutes to yesterday values, and resets Flow Minutes Today and Acc Volume Today.

¢ Manual Only — Contract hour is ignored.

Reset Accum- Select the accumulated reset option:
¢ Idle — Normal state, no action taken.

¢ Reset Now — Forces transfer from Flow Minutes Today to Flow Minutes Yesterday,
Acc Volume Today to Acc Volume Yesterday, and sets Acc Volume Today and Flow Minutes
Today fields to zero.
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Densities
Input Value — Displays actual input read (or set) density in kg!mg‘, Ibm/cft, or Deg APL

Flow Conditions — Displays actual flow density used in calculations in kg/m’, Ibm/cft, or Deg
APL.

At Contract — Displays actual base density used in calculations in kgfm3 , Ibm/cft, or Deg APL.

Correction Factors
With Temperature — Temperature Correction factor currently used in flow calculation.

With Pressure — Pressure Correction Factor currently used in flow calculation.

Meter Slippage — Actual Meter Slippage factor used in calculations. The value is read-only and
values are calculated and transferred from the Meter Slippage screen. Refer to Section 3.1.5,

Slippage Factors, on page 3-7.

3.1.2 Volume-Time Snapshot

Select API2540 > API 2540 Setup and click Volume-Time Snapshot to view Rates-Volumes and Flow
Minutes.

Vo lume-Time Snapshot

Figure 3-3. Volume-Time Snapshot

Rates-Volumes
Inst Flow Raw — Displays daily flow uncorrected in mf'fday or bbl/day.

Inst Flow Corrected — Displays daily flow corrected to contract conditions in mjf’day or bbl/day.

Acc Volume Today — Accumulated corrected volume since contract hour or last manual reset,
flow units. At contract hour or manual reset, values transfer to Flow Minutes Yesterday.

Acc Volume Yesday — Accumulated corrected volume yesterday, flow units.

Acc Volume Forever — Accumulated corrected volume since last rollover, flow units. Rollovers at
9,999,999 (ten million less 1).
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Flow Minutes
Today — Flow Minutes Today.

Yesterday — Flow Minutes Yesterday.

Hrs. Forever — Flow Hours Forever.

3.1.3 Alarms

Select API12540 > API 2540 Setup and select Alarms Enabled. Click Alarms to define low, high, low
flow alarms and Spontaneous Report-by-Exception (RBX) Alarming. Refer to Figure 3-4.

Dizabled
OJn Alarm Set
Jn Alarm Clear

On Alarm Set & s A

Figure 3-4. Alarms

Low Flow Cutoff — When the Meter Input value of the metering device 1s less than the Low Flow
Cutoff value, the calculated flow is equal to zero, (m?’fDay’ or BBL/Day).

Low Alarm — Limit value, in engineering units, to which the calculated tflow must fall to generate a
Low Alarm, (m’/Day or BBL/Day).

High Alarm - Limit value, in engineering units, to which the calculated flow must rise to generate a
High Alarm, (mEIDay or BBL/Day).

RBX Alarming — Currently, there are no communication programs available to handle API 2540
notifications. However, the alarms and Spontaneous Report-by-Exception (RBX) tags are logged
into the Alarm Log.

Disabled — Select Disabled to turn RBX Alarming Off.

On Alarm Set — When the point enters an alarm condition, the ROC generates a Report-By-
Exception message.

On Alarm Clear — When the point leaves an alarm condition, the ROC generates a Report-By-
Exception message.

On Alarm Set & Clear — In either condition, an RBX message generates. Note that RBX
Alarming also requires the communications port to be properly contigured.

Active Alarms — Displays any alarms that are currently active.
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3.1.4 Inputs

Select API12540 > API 2540 Setup and click Inputs to define the Meter Input, Temperature Input, Static
Prs. Input, Vapor Prs. Input, Density Input, and Sediment & Water inputs.

Figure 3-5. Inputs

Meter Input — Source of the uncorrected measured flow. Typically, this links to a Pulse Input
engineering units Value, or the Analog Input Filter engineering unit value. Softpoint parameters,
FST Registers, or manual (Undefined) mode are also accepted. The value transferred or set
displays as the (Meter) Value field.

When using a Pulse Input, this is typically configured as “rate,” but the user program calculates
pulse values starting from the Accumulated Pulses (Accum’d Pulses) in the Pulse Input (m’ or kg
for metric and bbl or Ibm for US). If the Meter Type is configured as Pulse Input, and the actual
value 1s manual (Undefined), or from a different register in the ROC (such as a Softpoint), the user
program interprets the number as a daily rate (kg, m’, Ibm or bbl per day).

When using an Analog Input, such as from a Vortex transmitter, the rate must be m*/hour or
kg/hour in metric, and bbl/hour or Ibm/h in US units.

When using a differential Analog Input for orifice metering, the scaling must be kPa in Metric and

in. H-O in US units.

Temperature Input — Location where the process temperature of the fluid is originated. Typically,
this floating-point parameter is assigned to the “Filter” engineering units (EU) value of an Analog
Input. Softpoint parameters, FST registers, or manual (Undefined) mode are also accepted. The
value transferred or set displays as the (Temperature) Value in Deg C or Deg F.

Static Prs. Input — Location where pressure of the fluid 1s originated. The pressure 1s assumed to be
consistent with the Vapor Pressure. Typically, this floating-point parameter is assigned to the
“Filter” EU value of an Analog Input or MVS. Softpoint parameters, FST registers, or manual
(Undefined) mode are also valid. The value transferred or set displays as the (Pressure) Value in
kPa or PSI.

Vapor Prs. Input — Location where the vapor pressure of the fluid is originated. The vapor pressure 1s
assumed to be absolute pressure and consistent with the Process Pressure (see above). Typically,
this floating-point parameter is assigned to the “Filter” EU value of an Analog Input, Softpoint,
FST Register, or manual (Undefined) mode. The value transferred or set displays as the Value in
kPa or PSI.
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Density Input — Location where the density of the fluid is originated.

There are two typical practical applications:

1. This parameter is manually (Undefined) entered, to a value certified by a laboratory. The
Value is assumed to be at base temperature and pressure, except API rounding. No
corrections are made on this Value.

2. A flow density meter can be assigned to the “Filter” EU value of an Analog Input. The
current Value of the floating-point parameter 1s assumed at flow conditions, so temperature
and pressure corrections are applied. Softpoint and FST registers are also accepted. The
value transferred or set displays as the (Density) Value in kg / m’ or Deg APL

Sediment & Water Input — Analog Input weight percentage, such as from a BS&W device, Softpoint,
FST Register, or manual (Undefined) entry. Valid Domain 0-100.

3.1.5 Slippage Factors

Select API12540 > API 2540 Setup and click Slippage Factors to “fine tune” each individual meter,
based on proven calibration data described in API Manual of Petroleum Standards, Chapter 12. This
screen 1s only accessible for Pulse or Analog Meter Types.

Meter Slippage Factors

Figure 3-6. Meter Slippage Factors
Up to five different Meter Slippage Factors may be entered for various flow rates.

1. If the first flow rate is set to 0.0, the rest of the table is ignored and a Meter Slippage Factor of
1.0 1s used.

2. If only one flow rate / meter factor pair is entered, the program uses that Meter Slippage Factor
for all flow rates. Enter a unique Meter Slippage Factor.

3. If more than one flow rate / meter factor pair is entered, the program uses linear interpolation to

arrive at the Meter Slippage Factor for the current raw flow rate. Each meter flow rate entered
must be higher than the previous flow rate entered, such as:

Meter Value 1 < Meter Value 2 < Meter Value 3, and so forth.

4. If an error occurs due to improper configuration, such as negative numbers, the program sets
the Meter Slippage Factor to 1.0.

Meter Value 1 — First flow rate for 1™ Meter Slippage Factor. Typically 20% of maximum flow.

Factor 1 — Meter Slippage Factor for 1™ flow rate.
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Meter Value 2 — Second flow rate for 2"! Meter Slippage Factor. Typically 40% of maximum flow.
Factor 2 — Meter Slippage Factor for 2™ flow rate.

Meter Value 3 — Third flow rate for 3™ Meter Slippage Factor. Typically 60% of maximum flow.
Factor 3 — Meter Slippage Factor for 3" flow rate.

Meter Value 4 — Fourth flow rate for 4" Meter Slippage Factor. Typically 80% of maximum flow.
Factor 4 — Meter Slippage Factor for 4" flow rate.

Meter Value 5 — Fifth flow rate for 5" Meter Slippage Factor. Typically 100% of maximum flow.
Factor 5 — Meter Slippage Factor for 5" flow rate.

Calculated Factor — Displays the actual calculated meter factor to be used in calculations. The value

is transferred to the API Calculations (Figure 3-2) as Meter Slippage Factor.

3.2 Data Transfer

Select API2540 > Data Transfer to configure eight individual register data transfers. The values
defined in Source definition data 1 to 8 are transferred into target Destination data 1 to 8. The actual
value for each field displays in the corresponding Value field. Only floating-point values can be
transferred, even though other data options are selectable.

The Register Transfer screen 1s set to run by setting the Scan Period to a value greater than zero. The
actual Scan Time is typically 2 seconds.

= ROCLINK

e = pille B @S] Al
eter 0 D ta A 12548 isple

Hegizter Iranster 1 of 4

Open ROC files, Connect ROC, ... On Line:COM2

Figure 3-7. Data Transfer
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APPENDIX A STANDARDS

The following API and ASTM standards were used to develop the API12540 Liquid Volume Correction
User Program:

ASTM D 1250-80
Tables 34, 53, 53A, 53B, 54, 54A, and 54B

1980. Manual of Petroleum Measurement Standards
Chapter 11.1 of Volume Correction Factors Volume X - Background, Development, and Program
Documentation. API Standard 2540, first edition.

1984. Manual of Petroleum Measurement Standards
Chapter 11.2.1 of Compressibility Factors for Hydrocarbons: 638 - 1074 Kilograms per Cubic
Meter Range. American Petroleum Institute, first edition.

1986. Manual of Petroleum Measurement Standards
Chapter 11.2.2M of Compressibility Factors for Hydrocarbons: 350 - 637 Kilograms per Cubic
Meter Density (15°C) and -46°C to 60°C Metering Temperature. American Petroleum Institute,
first edition.

1981 reaffirmed 1987. Manual of Petroleum Measurement Standards
Chapter 12 of Calculation of Petroleum Quantities Field Manual. Section 2 of Instructions for
Calculating Liquid petroleum Quantities measured by Turbine or Displacement Meters. American
Petroleum Institute, first edition.

1993. Manual of Petroleum Measurement Standards
Chapter 21 of Flow Measurement Using Electronic Metering Systems. American Petroleum
Institute, first edition.

1990. American Gas Association. Report No.3 of Orifice Metering
American Petroleum Institute, third edition. API Manual of Petroleum Measurement Standards.

Chapter 11 of Physical Properties Data Addendum to Section 2, Part 2 Correlation for Vapor
Pressure for Commercial Natural Gas Liquids.
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APPENDIX B DOMAIN VIOLATIONS

Error Message Units Description

Low Temp. (Water) Metric | Temperature below 0 Deg C
US | Temperature below 32 Deg F
Low Temp. (O1l Prod) | Metric | Temperature below -18 Deg C

US Temperature below 0 Deg F

Low Temp. (LPG) Metric | Temperature below -45 Deg C

US | Temperature below -20 Deg F

High Temp (Water) Metric | Temperature above saturation curve at actual pressure
US Temperature above saturation curve at actual pressure
Critical Temp. LPG Metric | Temperature above 55 Deg C

US | Temperature above 120 Deg F

High Temp. (O1l Prod) | Metric | Pressure less than 500 kPa

Metric | Crude oil or gasoline, density 653-778.5, temperature over 90

Deg C

Metric | Crude oil or jet fuel, density 779.5-824, temperature over 125
Deg C

Metric | Crude oil or Diesel oil, density 824.5-1073, temperature over 150
Deg C

Metric | Pressure over 500 kPa, temperature over 90 Deg C

US | Pressure less than 75 PSIA

US Crude o1l or gasoline, density 50.1-100, temperature over 200
Deg F
US | Crude oil or jet fuel, density 40.1-50, temperature over 250 Deg F
US | Crude oil or Diesel oil, density 0-40, temperature over 200 Deg F
US | Pressure exceeding 75 PSIA, temperature greater than 200 Deg F
High Press. (O1l Prod) | Metric | Pressure exceeding 10300 kPa
US Pressure exceeding 1450 PSIA

Low Density Oil Metric | Crude o1l, density below 610.5 lf,:g;"m3
Low Dens. Gasoline Metric | Gasoline, density below 653 kg/m’
Low Dens. Jet Metric | Fuel Jet Fuel, density below 787.5 kg,f‘m3

Low Density Diesel Metric | Diesel oil, density below 829 kg;’mz
Low Density (P.drv) Metric | Oil products, press domain, density below 638 kg/m’

Low Density LPG Metric | LPG, density below 495 kg/m’

Low Trans Zone Metric | Density in transition area below 770.5 kg/m’

Low Density Oil US | Crude oil, density above 100 Deg API

Low Dens. Gasoline US Gasoline, density above 85 Deg API

Low Density Jet Fuel US | Jet Fuel, density above 48 Deg API

Low Density Diesel US | Diesel oil, density above 37 Deg API

Low Density (P.drv) US | Oil products, press domain, density above 90 Deg API
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Error Message Units Description
Low Density LPG US | LPG, density above 155 Deg API
Low Trans. Zone US | Density 1n transition area above 32 Deg API
High Density Oil Metric | Crude oil, density above 1075 kg/m’
High Dens. Gasoline Metric | Gasoline, density above 770.5 kg/m’
High Dens. Jet Fuel Metric | Jet Fuel, density above 829 kg/m’
High Density Diesel Metric | Diesel oil, density above 1075 kgfm3
High Density (P.dry) | Metric | Oil products, press domain, density above1075 kg/m’
High Density LPG Metric | LPG, density above 610.5 kgfm3
High Trans Zone US | Density in transition area below 48 Deg API
High Density Oil US | Crude Oil, density below 0 Deg API
High Dens. Gasoline US | Gasoline, density below 52 Deg API
High Dens. Jet Fuel us Jet fuel, density below 37 Deg API
High Density Diesel US | Diesel oil, density below 0 Deg API
High Density (P.drv) US | Oil products, press domain, density below 0 Deg API
High Density LPG US | LPG, density below 100 Deg API
High Trans. Zone Metric | Density in transition area above 787.5 1-<gf’m3
Low Sed & Water Sediment & water 1s negative
High Sed & Water Sediment & water is greater than 100%
Low Meter Factor Meter Factor below 0.2
High Meter Factor Meter Factor above 3
High Vapor Pressure Vapor Pressure greater than Static Pressure
Invalid Base Temp Metric | Base Temperature differs from 15 Deg C
US | Base Temperature different from 60 Deg F
Tables Not Found! API Tables 34, 53 and 54 not loaded or corrupted
Inside Domain (OK) All parameters within domain
Not Active!! Flow not running
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APPENDIX C ENGINEERING UNITS

Metric Units
Inputs Pulse Meter kg 1f mass, m” if volume
Analog Meter kg/hour if mass, m” if volume
Differential Meter kPa
Static Pressure kPa
Temperature Deg C
Density l<:gf’rn3
Viscosity cP
Outputs Flow E3 kg/day 1f mass, mE;’day it volume
Density kg/m’
US Units
Inputs Pulse Meter Ibm if mass, US bbl if volume
Analog Meter Ibm/hour if mass, bbl/hour if volume
Differential Meter inches Water
Static Pressure PSI
Temperature Deg F
Density Deg API 1if O1l Products, Ibm/cuft if water
Viscosity Ibm / ft*sec
Outputs Flow E3 Ibm/day if mass, US bbl/day if volume
Density Deg API if Oil Products, Ibm/cuft if water
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